CorelDRAW!5 (Revision E2) - Readme File (September 1994)

Read this file for last minute changes to CoreIDRAW Revision E2 information that is not
documented elsewhere.

INSTALLATION

CorelDRAW! 5 Re-installation

Important: If you already have CorelDRAW! 5 installed on your computer, Corel recommends
that you re-install CoreIDRAW!5 Revision E2 so that many of the common files shared by the
CorelDRAW suite of applications can be updated.

To remove CorelDRAW 5 from your hard drive:

1. Backup files containing user-definable information regarding Corel palettes, fill patterns,and
application configuration in the CoreIDRAW directory. For example, backup CorelDRAW files
coreldrw.bpt, coreldrw.dot, coreldrw.end, coreldrw.ink, coreldrw.cpl and coreldrw.ini.

2. Backup any custom *.pal files you have created.

3. Backup an work you may have saved in the CoreIDRAW directory.

4. Use File Manager to delete the CoreDRAW directory.

5. Delete the CorelDRAW 5.0 Group Icon. Progman.ini will be automatically updated.

The win.ini, progman.ini, and reg.dat files are backed up as win.cor, progman.cor, and reg.cor.
These files contain pre-installation copies of win.ini, progman.ini, and reg.dat. If Setup did not
run successfully, simply copy these files over the one Setup modified to restore the original files.
Refer to the CorelIDRAW! 5 Installation Guide for more information.

Product Serial Number

During installation, you will be prompted to enter your name and serial number. Although these
details are not required for successful installation, your serial number will be required for
Technical Support and if you enter it during installation, it will be visible in all About Boxes for easy
reference.

Upgrading from Corel VENTURA 4.2 to Corel VENTURA 5.0

In the CoreIDRAW! 5 Installation Guide, page 14 describes how "to remove CorelDRAW 4.0 from
your hard drive". If you installed VENTURA 4.2 into the \CORELA40 directory, deleting the \
CORELA40 directory will also delete the VENTURA 4.2 program files. If you wish to keep
VENTURA 4.2 on your computer, you may opt to skip this step.

Installation TEMP Paths

Typically, applications store temp files in the directory pointed to by the TEMP environment
variable. The application is then limited to the available space on the drive that the TEMP
variable points to. With graphics applications dealing with large bitmaps, this amount of space
may not be enough at times. By setting various alternative places where TEMP files can be
stored, CorelDRAW applications can take advantage of other drives or partitions the user has for
temporary storage, instead of being unable to complete the task due to a lack of free space on
the one drive pointed to by TEMP environment variable.

Compression issues and the TEMP directory
It is recommended that the TEMP directory be created and reside on uncompressed drives.



Serial Number
The serial number can be found just inside the cover of the CoreIDRAW!5 User Manual Volume
1, on the top right corner of the technical support card. Please enter the number in the following
format:

CD5-123-456789

Screen Savers during install
To speed up the install process, close any screen saver that you may have active. Once the
install is complete, you can re-activate the screen saver.

Installation and SMARTDRIVE

The Setup routine was designed to work best with SMARTDRV.EXE, using the default options.
Do not disable the floppy drive read cache. Note that the absence of a disk cache and some
third-party caches will increase the installation time.

Audible prompts

When installing CorelDRAW!5 from diskettes, ensure that the "Enable System Sounds" is
enabled in the Sound utility of the Control Panel in order to receive an audible beep during
prompting to insert the next diskette.

Diskettes and Compression

The diskette version of CoreIDRAW uses a new file compression technology. This technology
causes some files to appear as if they have a 0-byte file size. Don't be alarmed, and don't delete
these files. These files are used during the installation process to perform decompression tasks.

Compression and Microsoft EXPAND.EXE

Since the diskette version of CoreIDRAW has been compressed using a new compression
technology, users will not be able to use the Microsoft EXPAND.EXE utility. To decompress
individual files, use the SETUP /Z command as documented in the Installation Guide.

Acrobat (TM) Reader Serial Number

When installing Acrobat Reader \READER\DISK1\AASETUP.EXE) from CorelDRAW! 5
CD-ROM DISK 1, you will need to type the following serial number when prompted:
ARW100R3100000-500-574

Changes to directories in CD-ROM

With the addition of Corel VENTURA to CD-ROM Disk 1, the following directories
have been moved to CD-ROM Disk 2:

\SOUNDS

\SHOW\FLICS\GENERAL

The ~COREL.T Directory

During the installation of CoreIDRAW, SETUP will create the ~COREL.T temporary directory. This
directory is deleted when SETUP has completed successfully. If you notice that ~COREL.T
remains on your hard drive, you can delete this directory using File Manager.

Installing CoreIDRAW on a Network

When installing CorelDRAW on a network, Corel recommends that you install all applications and
program files. This way, users setting up CoreIDRAW 5 on a user workstation can select from
any of the Corel applications.



COREL SUPPORT SERVICES

Corel recognizes that support needs vary from user to user, and we offer you a wide range of
choices when you need answers to your technical queries and problems in using the CoreIDRAW
applications.

If you have a question about CorelDRAW features and functions, first look in the CorelDRAW!5
Manual or consult on-line Help. You can also find late-breaking updates and technical
information by double-clicking the Readme icon in the CoreIDRAW!5 program group (this file).

Corel is committed to providing customers with high quality, timely technical support. Technical
Support Representatives are available, on a 1-800 line, to answer your technical questions. A fee
will be charged for the technical support, but there will be no additional charge to your telephone
bill. Alternatively, you may opt to call on a 1-900 line (Continental U.S. only). You will not be
charged by Corel for this support option, but a charge will appear on your telephone bill. We also
offer a number of Free Support options which you can access at any time. Refer to the Technical
Support reference card for more information.

Each CoreIDRAW!5 product will include two free technical support credits in the box. These
credits will be valid for two technical support calls. The technician answering the call will not use
your credit if the issue which you are calling about is a known or documented problem, with the
software, which does not have a fix.

After you have used your free credits, you will have the option of buying additional credits as
follows:

One credit - $25.00US/$30.00CDN
A five-pack of credits - $100.00US/$120.00CDN
Aten-pack of credits - $175.00US/$240.00CDN

If you do not have any remaining credits when you place your call, the technical support
representative you reach will be able to sell one of the above options.

You can reach a representative Monday to Friday, 4:00am to 8:00pm Eastern Time, excluding
holidays at 1-800-818-1848.

Refer to the Technical Support reference card or the On-line Help for more information.
Note to VENTURA 5.0 Users
Corel will offer a free period of support for VENTURA 5.0 only on the 1-800 support line, to end

November 15, 1994 to address the technical learning curve associated with a new release of this
magnitude.



RUNNING THE CD-ROM QUICKTOUR

The CorelDRAW QuickTour is a multimedia tutorial, designed to introduce the user to the
CorelDRAW!5 applications in a fun and informative fashion.

Installation
Note: When installing and running the QuickTour, make sure that CD #2 is in the drive.

(a) To install the QuickTour, open the Program Manager and from the
File Menu, select Run...

(b) In the Run dialog, enter:
FAQTOUR\SETUP.EXE (where F is the drive letter of your CD-ROM)

(c) From here, simply follow the instructions as they appear during the
setup program.

To close the QuickTour simply select CLOSE from the Control Menu Box, located in the upper-left
corner of the QuickTour Window or select EXIT from the Channel Guide buttons.

System Requirements
To run the Quick Tour, you'll need at least a MPC Level 2 compliant computer. This would consist
of a computer that meets the minimum configuration listed below:

486 or compatible processor

4MB of Ram

160MB hard drive

Double Speed, XA ready, multisession capable CD-ROM Drive
16 Bit Sound

Display Resolution of 640x480 with 65,536 colors

We have taken steps to allow the QuickTour to run on more marginal computers.

Known problems

- The Corel QuickTour was designed to run on a VGA or SuperVGA display and adapter. If you
are running an 8514/A, XGA or other display with a dpi (dots per inch) value different than VGA,
you may experience some display problems. For example, VGA uses 96x96 dpi while an 8514/A
uses 120x120 dpi. This difference in dpi would cause certain bitmaps to appear smaller than
intended.

To rectify this problem simply change to a VGA- or SuperVGA-compatible display driver. Your
driver can be of any resolution or color depth, however, the ideal setting is 640x480 with 65,536
colors.

Some higher resolution display drivers, such as 1024x768, will have an option to use large fonts.
This option will run the display in a higher dpi mode than regular VGA, and the same problem
mentioned above will occur. By running your 1024x728 driver in normal or small font mode, the
problem should not occur.

- On some machines, running the ATl Graphics Ultra PRO with the QuickTour may cause palette
problems when you exit from a MS-DOS box and re-enter the QuickTour program. Certain
QuickTour elements may appear dark gray. Once an animation or interview is loaded, the palette
is properly restored.

- If you are using the Multimedia Video Acceleration drivers for the ATl Graphics Ultra PRO (or



similar card), and the introductory screen or animations are skewed, or are black, you need to
update your video drivers or disable the Accelerated Video. To do this you would use your DOS
install program to uninstall your Windows 3.1 Video Drivers. You would then install your ATI
drivers again, this time selecting Video Drivers only. For more detailed information please see the
ATl manual on disabling the Acceleration Video Drivers.

New Features in Version 5.0 Revision E2

DRAW Features

- Ciceros and Didots added to list of selectable units of measure wherever picas and points
appear. See On-line Help for more information.

- Printing from the Object Data Manager now uses the common print dialog.

- You can now select texture resolution/size from within the texture dialog.

- The CMX file format is now available in the list of export file types.

- Emulsion, Negative, Densitometer and Colorbar controls are now available for use in composite
printing as well as in printing separations.

- When doing color separations, CorelDRAW and Corel VENTURA will detect colors used in EPS
files imported using the "EPS (Placeable) (*.eps,*.ps,*ai)".

- When Preview Image (Print Options dialog box) is deselected, the print area occupied by all
objects is now shown by a Grey rectangle with an X'in it.

PHOTO-PAINT Features

- The magic wand, lasso, and the flood fill now work faster.

- Holding down S key on button-up snaps the Clone tools anchor point back to its original
position.

- "To Mask" and "Reset" options have been added to the color mask Roll-up. "To Mask" creates a
regular mask from the color mask. "Reset" resets the color mask, colors and tolerance
values to the default.

- Resample dialog functionality is improved.

- Color tolerance dialog has "Hue, Saturation, Brightness" (HSB) mode and is context sensitive to
image type.

- Revert menu item added to file menu. Revert reloads the most recently saved version of the
current file.

- Last Filter menu item added to effects menu. Last Filter runs the last executed filter on the
current image.

- Photopaint supports any plug-ins that conform to the Adobe Photoshop standard plug-ins.

- The Plug-in filters now remember the last parameters used.

- Masking now supported in the plug-ins. If a transparency is present, the image is passed to the
plug-in as an 8-bit mask. Currently, only Kai's Power Tools Gradient-on-a-Path plug-in
exploits this feature.

- When filters are applied to a partially loaded file, the entire image is affected and not just the
partial area loaded. This allows huge files to be filtered on disk.

- There is a new dialog box - "Transparency Mask Creation" that allows you to create a
transparency from a mask.

- There is now no limit on cropped image size. If the cropped image size is > 16MB, the partial
loading feature is activated.

- Holding down SHIFT + CTRL switches direction between horizontal and vertical for Freehand
tools.

- You can display the Pen/Paper/Fill Roll-ups by double clicking the appropriate icon in the Status
bar.

- A"Remove" button has been added to the Canvas rollup. You click this button to remove the
current canvas from the image. Previously, to remove a canvass, you had to chose "None"
and then click Apply.

- New Merge modes for objects have been added. These include: Add, Subtract, Difference,



Multiply, Divide, Hue, Saturation, Brightness, RGB, CMYK, etc.
- "Hide Unselected" and "Show All" buttons have been added to the Layers/Object rollup.
- Optimized conversions from 24 bit to 256 color formats now produce significantly better images.
- Object feathering capabilities have been enhanced.
- Mask/Object brush tool supports XOR mode.
- When exporting as an EPS, the current mask is converted to clipping path.

Changed Key Stokes From To
Canvas Rollup F3 Ctrl-F3
Color Mask Rollup F4 Ctrl-F5
Color Selection Rollup F2 Ctrl-F2
Fill Rollup F6 Shift-F6
Layer Rollup F7 Ctrl-F7
Tool Rollup F8 Ctrl-F8
New Key Strokes Accelerator

Mosaic Rollup Alt-F1

Display Rulers Ctrl-R

Zoom in one level F2

Zoom out one level F3

Zoom to fit F4

Select Pen Tool F5

Select Rectangle Tool F6

Select Ellipse Tool F7

Select Text Tool F8

CHART Features
- CorelCHART now allows you to import and export Microsoft EXCEL 5.0 files.
- Scatter charts now support data analysis.

MOVE Features
- An option for "Constant" was added to Cel Sequencer roll-up. This option displays selected cels
the same size as the first cell of the selected frame range.

- Pure "OPAQUE" can be differentiated from "TRANSPARENT" white in the following situations:
- Move's paint editor ("TRANSPARENT" white is identified in the paint editor's palette by an X),
- any OLE editor being used for actors/props,

- anything pasted as an actor/prop from the clipboard

-Improved Sound Engine

The option of using a new improved sound engine has been added. The new engine supports
individual volumes for each sound, and allows you to assign left and right channels. It is also far
less susceptible to the skipping problems that the old engine had.

To activate the new sound engine, set NewSoundEngine=1 in the C:\COREL50\CONFIG\
CORELMOV.INI file. The parameters which follow it influence the quality of playback. To use the
default sound engine set NewSoundEngine=0.

The value "NumWavePages=4 and WavePageSizelnMs=400" is optimal on most systems.
Ideally, both of these should be set as small as possible as long as skipping does not occur.
Using smaller values for these parameters decreases the delay between the ideal beginning and
actual beginning times for sounds.

The minimum values for these parameters are NumWavePages=4 and WavePageSizelnMs=10 .
If you find a value for WavePageSizelnMs for which this delay is acceptably short, but skipping



starts to occur, try increasing NumWavePages. Otherwise if the delay is not serious, increase
WavePageSizelnMs to eliminate the skipping.

GENERAL

Color Correction and ATI MACH32 screen drivers

There is a problem with earlier ATI Mach 32 video drivers and Color Correction in CorelDRAW.
If you use a driver earlier than 2.3 and you experience color correction problems, you

should upgrade to a more recent version of the driver from ATI.

See the ATl manual for technical support information.

Printing Separations of Chapters Containing Multiple Colors

When outputting separations of chapters that contain multiple colors, it is possible that blank
separations will be printed. This will happen if one page contains colors that another page in the
same chapter does not.

Workaround: When outputting separations for imagesetter or other service bureau work, it is
always best to proof the entire job on a local PostScript printer first. Once a local proof has been
examined, you can determine which, if any, separations can be eliminated. You can then create
.PRN files for each separation color containing only the range of pages relevant to that
separation. Use the regular Print... feature (as opposed to the Print Publication... feature) in order
to specify these page ranges.

Corel Presentation Exchange Data

The Corel Presentation Exchange Data (CMX) is new for CoreDRAWS. It allows you to save files
so they can be used in any Corel application. This is more efficient because Corel applications
can open or import such files directly.

Using Presentation Exchange Data provides multiple benefits and Corel encourages their use.
The following is a list of those benefits:

- Most importantly, CDR and CCH files can be imported DIRECTLY into Corel VENTURA, Corel
PhotoPAINT and CorelCHART.

- CDR and CCH files can be quickly previewed and printed in full quality from CorelMOSAIC. If
the file DOES NOT contain the Presentation Exchange Data, CoreIMOSAIC has to start the
application (CoreIDRAW and CorelCHART) to display the file.

- Corel is committed to supporting the CMX format. All of Corel's future applications will use it.

Using Presentation Exchange Data results in bigger file sizes. Typically these files are about 30-
60% larger. If the benefits of Presentation Exchange Data are not important to you, simply turn off
the Presentation Exchange Data option in the appropriate dialog boxes when saving files.

The Presentation Exchange Data format is a new concept introduced in CorelDRAWS. Files
generated with previous versions of Corel applications don't contain Presentation Exchange Data.



Temporary (Temp) files

Each time you open a Corel application, a temp file ~CDRnnnn.tmp is created in a temp directory
you specify during install. These files are normally deleted upon closing the application. When a
Corel application is launched, it looks in the Corelapp.ini file for:

[TempPaths]
Cleanup=1
0=D:\Temp
1=E:\Temp

If Cleanup=1, the application does not clean up the temp files on the hard drive when it is
launched. It assumes that the temp files were cleaned up during the last session.

If Cleanup=0, the application did not exit normally during the last session. On the next launch, the
application searches temp directories for any temp files and deletes them.

The Cleanup switch should not be edited manually. If there is a problem with Temp files not
being cleaned up, please contact Technical Support.

The application searches the following paths in that order when looking for temp files for
manipulation:

Set Temp=DosTempPath <-- the Temp variable specified in the AUTOEXEC.BAT

Ex: SET TEMP=E:\

User Temp Path <-- [TempPaths] in the CORELAPP.INI file [defined during setup
or by user]

Ex: 0=D:\TEMP
Ex: 1=G\TEMP1 etc...

Windows Path <-- the Windows directory for the current Windows session.
Ex: C:\WINDOWS

While the application is searching for and/or cleaning up temp files on the hard drive the user will
see an hourglass. When this operation is complete the application will continue. This can occur
when the opening screen is launching, when you are exiting, or while you are working in the
program.

Note: If you did not select any temp paths during the install, Cleanup=1 will be the last line in the
[TempPaths] section.

Note2: It is recommended that files in the Temp directory be deleted only from DOS. Windows
should always be closed before deleting temp files.

Microsoft Mouse Driver 9.0

- If you have a Microsoft version 9.0 mouse driver, and have the Snap-To feature in use, double
clicking on a roll-up Control Box sends the pointer to the bottom of the screen and leaves the roll-
up open. In some cases, the cursor may be moved to the button in the roll-up that has the focus.
- The magnify feature provided with the Microsoft 9.0 Mouse Driver results in very long redraw
times in the magnified portion of the mouse pointer.

- Consider upgrading to Microsoft Mouse Driver 9.01 which corrects the Snap-To problem
described above.



CorelDRAW Applications and Windows Standard Mode

CorelDRAW applications require Microsoft Windows to run in Enhanced mode. Standard Mode is
not supported. For additional information on Microsoft Windows Enhanced mode, refer to the
Windows documentation.

Object Linking and Embedding

When inserting large or complex OLE objects, especially ones containing large high-resolution
bitmaps, you may encounter problems depending on available memory and system resources.
This is a known limitation of the Microsoft OLE2 DLL's. If you experience problems trying to
insert large OLE objects (e.g. blank objects appear or General Protection Faults occur), the work-
around is to export the desired information from one application to a file on disk, then import the
file into the other application.

Shifting OLE from CorelDRAW 4 to CorelIDRAW 5

OLE objects in files created with CorelDRAW 4 are automatically converted to CoreIDRAW 5
objects when the (CorelDRAW 4) file is opened in CoreIDRAW 5. This is because CoreIDRAW 5
overrides the registration database in OLE2 during the installation procedure.

The utility disables the OLE2.0 automatic conversion which converts all CoreIDRAW 4 OLE
actions to CoreIDRAW 5 OLE actions. It does this by modifying the OLE registration database
and removing the keys which cause the conversion to occur.

To disable this automatic conversion process, simply start the file manager and locate the
directory where all CoreIDRAW 5 programs are installed. (This is typically: <drive>:\COREL50\
PROGRAMS) Click on CDRNOCON.EXE in the file manager and then select "File" menu "Run".

To restore the automatic conversion process, run the same utility but add /R to the end of the
command in the file manager "Run" dialog box.

Monitor display

Some video cards have device drivers that do not support the Microsoft Windows API
StretchDIBits. If your video card/monitor is having difficulty displaying images, consult with your
video card manufacturer for driver updates to correct this problem.

NEW and Old Pantone Colors

A revised Pantone spot color table has been added in this revision. This new table now contains

the most up-to-date, complete and accurate color specifications from Pantone. Users of

CorelDRAWA4.0 and earlier versions may experience differences in the appearance of the

Pantone Spot colors that they have been using in CorelDRAW files. These subtle differences can

be seen both on the screen and on printed output.

1. In the "COREL50\PROGRAMS\DATA" directory, Rename CORELDRW.INK to
CORELS50.INK

2. In the "COREL50\PROGRAMS\DATA" directory, Rename COREL40.INK to
CORELDRW.INK

This will cause the Pantone spot colors to look and print exactly the same as in CorelDRAW 4.0

and previous versions.

Texture Fill dialog box

New Texture Samples

The "Samples 5" library available in the Texture Library list, contains a series of textures that have
been created from Version 5 textures. These look very different from the textures from which they
were built and are included as examples of how you can make your own custom textures.

Options Button
Displays a dialog box that allows you to change DPI for textures in your images.



Using CoreIDRAW! 5 in Windows Compatible Environments
The CorelDRAW! 5 suite of applications have been designed and tested to operate with the
following Windows environments (with MS-DOS):

o Windows 3.1
o Windows 3.11
o Windows for Workgroups 3.11

While every effort has been made to ensure that the CoreIDRAW! 5 suite of applications run
under Microsoft Windows NT and IBM OS/2 V2.X, unsupported API's in the 16-bit to 32-bit
conversion (thunking layer) may affect the usability and performance of the CorelDRAW
applications. These limitations may exist in the NT and OS/2 Windows support, and not with the
CorelDRAW applications.

If you discover incompatibilities running under NT or OS/2, contact either Microsoft or IBM for
technical support.

Vector Graphic Imports and Font Mapping

CDR, CMX, WMF and EPS (placeable) import filters offer the best font mapping. Other vector
import filters (such as DXF and CGM) map all text to a single default font. This default font is
usually Avant Garde. If Avant Garde is not installed, then the default is usually the first font listed
in the [Fonts] section of the WIN.INI file. If you wish to wish to use a different font, you should
update your source file using the application which generated the file, and save the text as curves
(rather than text as text). This will result in the font being correctly displayed after being imported.

CorelDRAW

Using the Corel Libraries Catalog

The documentation refers you to the diskettes for clipart and symbols. However, none of the
clipart is available on floppies and only some of the symbols are contained on the floppies. All
clipart is available on the CD-ROM only.

Clipart Updates
For a list of clipart changes, refer to the CLIPART.WRI file on the CoreIDRAW! 5 CD-ROM Disk 1
in the \CLIPART directory root.

Color Palette (video drivers supporting 256 colors only)

When you have one of the color selection dialogs open keep in mind that pressing ALT + TAB
may temporarily interfere with color display. Minimizing and Restoring CorelDRAW will correct
this.

PowerClips

A nested PowerClip that contains groups of objects in each level can experience problems
displaying or printing all of the objects in the inner most level. This problem is related to the
PowerClip's position on the page. Moving the PowerClip slightly on the page will correct this.



Cloning PowerClips that contain groups of objects can result in the PowerClip contents of the
Clone being shifted within the PowerClip. If you Clone a PowerClip, the contents of the Cloned
PowerClip will change position on the page if you rotate the Master. Selecting the Clone and
deselecting Lock Contents will alleviate the problem provided the Master PowerClip is not part of
a group of objects.

Screen Redraw & the Hourglass

CorelDRAW 5 supports several types of complex objects including PowerClips and Lenses. As
you are working with these objects, and as they become more complex, it takes a lot of resources
to rebuild and re-display them. You will find that there are times when your objects are not visible
on the page; CorelDRAW is recalculating the objects. This state is interruptible but once
interrupted CorelDRAW will have to begin the calculations again before it can display the objects.
During these states, you do not have an hourglass, as this would denote that CoreIDRAW is busy
performing a function that cannot be interrupted.

Fonts
During the installation, five basic fonts are installed:

Avant Garde Book BT,

Avant Garde Book Oblique BT,

Avant Garde Medium BT,

Avant Garde Medium Oblique BT, and
CommonBullets

These fonts are installed whether True Type fonts are selected or not, as they are required as
default fonts in the CORELDRW.CDT. The defaults may be changed/updated in CorelDRAW.
Please refer to 'Changing the default styles' section in On-Line help or Chapter 14-Using Styles
and Presets in the CoreIDRAW!5 User Manual Volume 1.

Print previewing a file

If you are experiencing problems using print preview on a file, try to obtain an update of the ATI
MACH32 driver or amend the [Mach] section of WIN.INI from the default DeviceBitmap=on to
DeviceBitmap=off. Note: With this setting bitmaps may not display as nicely on-screen.

Using PENWIN.DLL (supports pressure sensitive pointing devices)

If you are experiencing the insertion of unwanted characters into Text objects highlighted for on-
screen editing please ensure that you are using the WINTAB.DLL driver for your pointing device
instead of PENWIN.DLL. The manufacturer of your device may have shipped WINTAB.DLL with
its driver, please check your diskette.

For example; create a string of artistic text on-screen. With the Text Tool still selected, wipe some
characters. When the cursor is dropped into the text string additional characters are also
inserted.

To correct this problem install the WINTAB.DLL according to the manufacturer's documentation.
If you do not have a copy of the WINTAB.DLL contact the manufacturer of your pointing device.

To correct this problem install the WINTAB.DLL driver instead of PENWIN.DLL. See the
manufacturer's documentation for further information.

If you continue to have problems, contact the manufacturer of the pointing device.



Installing a foreign-language dictionary

If you have the CDROM version of CorelDRAW, you can install dictionaries
to check the hyphenation and spelling of words in other languages. You can
also install a foreign-language thesaurus to look up synonyms in other
languages.

To install a foreign language dictionary:

1. Copy the files from the \SPELDICT directory on the CD-ROM Disk 1 to the
CORELS50\CUSTOM directory on your hard disk.

2. Using Windows Notepad or other ASCII text editor, open the CORELAPP.INI
file in your COREL50\CONFIG directory.

3. In the [Config] section, locate the line SpellLanguage.

4. Type the language you want to install. Your choices are:

English, French, German, Swedish, Spanish, Italian, Danish, Dutch, Finnish, Norwegian,
and Portuguese.

5. Locate the lines SpellDict, HyphenateDict, and Thesaurus Dict, then change them

to match the SpellLanguage you specified.

Language SpellDict HyphenateDict Thesaurus Dict
Danish idnf9341.dat  hdndy232.dat rdntf300.dat
Dutch iduf9320.dat  hduds321.dat rdutf300.dat
English ienc9231.dat hendp148.dat renti301.dat
Finnish ifnf9310.dat hfndy141.dat  rfntf211.dat
French ifrf9221.dat hfrds221.dat  rfrif222.dat
German igrfa310.dat hgrds311.dat  rgrtf300.dat
Italian iitf9260.dat hitds262.dat  rittf210.dat
Norwegian inof9320.dat  hnody321.dat rnotf313.dat
Portuguese ipof9124.dat  hpody141.dat rpotf321.dat
Spanish ispf9332.dat  hsprs311.dat rsptf302.dat
Swedish iswf9310.dat  hswds311.dat rswtf300.dat
British rbrt1311.dat
English hemdp231.dat(this is a medical hyphenator)
Finnish ifnx9300.dat(this is a morphological dictionary)

Note: The Thesaurus you install doesn't have to be the same language as the SpellDict
or HyphenateDict. However, the SpellDict and HyphenateDict must be the same language.

6. Save the file.
For the change to take effect, you must close and then restart CoreIDRAW.

Grouping Objects and File Size

Files created with CoreIDRAW! 5 (Version D1) which contained groups of objects which had been
moved or duplicated would exhibit increased file sizes for no apparent reason. Files with this
problem will be automatically deflated when the file is resaved. Once this correction has been
performed for CoreIDRAW! 5.0 (Version D1) and CorelIDRAW! 5 (Revision E1) files, users will
experience increased performance during FILE-OPEN.

File Open of Artistic Text Optimized
The performance of FILE-OPEN for files containing numerous strings of artistic text has been
optimized. Users will experience reduced FILE-OPEN times for these files.



Corel VENTURA

What’s New: Corel VENTURA 4.2 Vs Corel VENTURA 5.0

For a complete list of changes and enhancements between Corel VENTURA 4.2 and Corel
VENTURA 5.0, refer to the “What's New 4.2 vs 5.0” button on the Corel VENTURA Help Contents
dialog box.

System Requirements to run Corel VENTURA 5.0
The following are the recommended system requirements for running Corel VENTURA 5.0:

Processor: 486

RAM: 16 megabytes

Display: SVGA

Other: Mouse, CD-ROM drive, Math Co-processor, Windows 3.1 or higher

The following are the minimum system requirements for running Corel VENTURA 5.0:

Processor: 386

RAM: 8 megabytes

Display: VGA

Other: Mouse, CD-ROM drive, Windows 3.1 or higher

In order to have enough memory to run Corel VENTURA on a 386 computer, you will probably
need to create a swap file. For instructions on doing this, refer to your Microsoft Windows User's
Guide.

Backup VENTURA 3.X and VENTURA 4.X Documents

Files created using VENTURA 3.X and VENTURA 4.X and saved using Corel VENTURA 5
will no longer be usable with VENTURA 3.X and VENTURA 4.X. Corel recommends that you
backup these files prior to using them in Corel VENTURA 5.

Printing Separations of Chapters Containing Multiple Colors

When outputting separations of chapters that contain multiple colors, it is possible that blank
separations will be printed. This will happen if one page contains colors that another page in the
same chapter does not.

Workaround: When outputting separations for imagesetter or other service bureau work, it is
always best to proof the entire job on a local PostScript printer first. Once a local proof has been
examined, you can determine which, if any, separations can be eliminated. You can then create
.PRN files for each separation color containing only the range of pages relevant to that
separation. Use the regular Print... feature (as opposed to the Print Publication... feature) in order
to specify these page ranges.

CD-ROM - Opening sample publication and chapter files

Sample publication and chapter files from VENTURA\TYPESET and VENTURA\VPSTYLE
directories cannot be used directly from the CD-ROM. The sample files must be installed to

the hard disk by using the Minimum/Custom installation from SETUP.EXE. Deselect other
components and select VENTURA. Click on the CUSTOMIZE button, and select Samples from
the Corel VENTURA Options dialog box.



Importing .CDR Files

CDR files saved without Corel Presentation Exchange Data (CMX) will not load into Corel
VENTURA. To get around this, load the .CDR file into CoreIDRAW! 5 and resave it with Corel
Presentation Exchange Data.

Older File Formats
Several older word processing file formats are no longer supported by Corel VENTURA 5.0.
These file formats are:

- Multimate
-DCA

If your document contains a word processing file that is no longer supported, then perform the
following steps to convert the file to a supported format:

- Open the document in the previous version of VENTURA, Select Frame - File/Type Rename.
- Change the document type to a supported file format.

- Save the Chapter.

Other graphics file formats not supported by Corel VENTURA 5.0 will need to be converted to a
graphics file format used by Corel VENTURA 5.0. These unsupported file formats are:

- MacPaint

-DCS

Color in Previous Versions of Corel VENTURA

Corel VENTURA 5.0 supports PANTONE Spot Colors, TRUMATCH Process Colors and
FOCOLTONE Process Colors. Spot colors that were defined in style sheets in previous versions
of VENTURA will be loaded as PANTONE Spot Colors. To change these colors, you need to
make your selections on the appropriate dialog box. For example, to change the color of text,
use “Selected Text...” item from the Format Menu.

Modified Filter Support

In Corel VENTURA 5.0, changes have been made to the support for filters to provide a literal
interpretation. This has implications for older VENTURA files because codes inserted into the
text, which were not interpreted by previous versions of VENTURA, will now be translated. If you
experience problems of this nature, you should re-examine the codes in your word-processor file.

For example:

- If a number of paragraphs had been underlined in a word-processor-generated text file, older
versions of VENTURA would only have displayed the underlining in the first paragraph. Corel
VENTURA 5.0 will display all underlined characters.

Installing a foreign-language dictionary

If you have the CD-ROM version of Corel VENTURA, you can install multiple dictionaries to
hyphenate and check the spelling of words in other languages. To install a foreign-language
dictionary:



1. Copy the files from the SPELDICT directory on the CD-ROM Disk 1 to the COREL50\CUSTOM
directory on your hard disk. The choices are:

Language SpellDict HyphenateDict
Danish idnf9341.dat  hdndy232.dat
Dutch idnf9320.dat  hduds321.dat
English ienc9231.dat hendp148.dat
Finnish ifnf9310.dat hfndy141.dat
French ifrf9221.dat hfrds221.dat
German igrf9310.dat hgrds311.dat
Italian iift9260.dat hitds262.dat
Norwegian inof9320.dat  hnody321.dat
Portuguese ipof9124.dat  hpody141.dat
Spanish ispf9332.dat hsprs311.dat
Swedish iswf931.dat hswds311.dat

Note: If you want to have both hyphenation and spell checking occur in
the chosen language, both files (SpellDict and HyphenateDict) must be
copied to COREL50\CUSTOM.

2. Create a paragraph tag using the Paragraph Settings dialog boxes. The dictionary is selected
in the Typography page. Note: The selected dictionary is assigned to the paragraph tag and
spell checking automatically occurs in the selected language.

Installing a foreign-language thesaurus
1. Copy the files from the SPELDICT directory on the CD-ROM disk #1
to the COREL50\CUSTOM directory on your hard disk. The choices are:

Language ThesaurusDict
Danish rdntf300.dat
Dutch rdutf300.dat
English renti301.dat
Finnish rfntf211.dat
French rfrtf222.dat
German rgrtf300.dat
Italian rittf210.dat
Norwegian rnotf313.dat
Portuguese rpotf321.dat
Spanish rsptf302.dat
Swedish rswtf300.dat

2. Using Windows Notepad or other ASCII text editor, open the CORELAPP.INI
file in your COREL50\CONFIG directory.

3. Locate the line "ThesaurusDict" and type the file name of the language
you want to use for the thesaurus (e.g., rdnt300.dat for a Danish thesaurus).

Hyphenation

Previous versions of Corel VENTURA did not save hyphenation module information in the chapter
or style sheets (it depended on the files located in the Ventura directory). Since Corel VENTURA
5.0 now saves hyphenation module information, you need to set the Default Hyphenation on the
General tab of the Preferences dialog box. This will set the default hyphenation when loading
older chapters. Changes to the default hyphenation are set within Paragraph Tags.



Line Endings
As mentioned previously, Corel VENTURA 5.0 supports multiple Houghton Mifflin hyphenation
dictionaries. Therefore, some of the line endings in your document will be adjusted.

Custom Page Sizes

Unlike earlier versions of VENTURA where custom page sizes were set manually in the base
frame Sizing and Scaling dialog box, Corel VENTURA 5.0 supports custom page sizes and can
automatically create custom page sizes for chapters saved in earlier versions.

When you open a chapter from an earlier version of VENTURA with a custom frame setting for
the base page, a dialog box will appear prompting you either to create a custom page size based
on the base frame or retain your original settings.

- click "Yes" and Corel VENTURA automatically creates a custom page size based on the base
frame size, or
- click "No" to retain the original settings. "

Reverse Text

Previous versions of Corel VENTURA automatically set text to white if used in solid black
box text or frames. These tags need to be changed from black to white text. When
opening these chapters in Corel VENTURA 5.0, the black frame/box text will appear with
no text. Select the tag or select the text and set it to white.

Line Attributes

Line Attributes will differ slightly between Version 4.2 and Version 5.0 due to the change from the
VENTURA graphics engine to the CoreIDRAW graphics engine. For example, dashed lines and
line endings are affected.

VENTURA Template Terminology
User's of Corel VENTURA 4.2 may be familiar with the term Design Gallery. The term Design
Gallery has been replaced with the term Publication Templates.

VENTURA File Import Auto-Sensing

When loading (importing) graphics and text files, selecting a file without specifying the specific
import filter will invoke the auto-sensing feature. Since many graphics and text files appear
similar, the auto-sensing feature may not accurately recognize the file format. To ensure correct
loading of graphics and text files, Corel recommends that you always identify the specific filter
after selecting a filename from the file list.

EPS Files

Corel VENTURA 5.0 supports the importing of Placeable Encapsulated Postscript files from
previous versions of Ventura Publisher, as well as from other applications. Corel VENTURA 5.0
will not support EPS files that have been printed from Corel VENTURA 5.0 through a postscript
printer driver (Users may have used this method, rather than a screen grab, to place an image of
a page in documents. In this case, you can use Corel CAPTURE to perform a screen capture).

Printing Publications with Chapters of different orientations.

Publications containing chapters with different orientations may not print correctly if the
orientation of the first chapter is the same as the orientation currently set up in the printer driver.
To avoid this situation the user may do one of two things:

1. In the CorelPrn.INI file there is a section called [Config] ... modify the line that reads
WarnBadOrientation= 1 to = 0. Note: Changing this switch will also disable the error message
warning for other applications such as CorelDraw and Corel PhotoPaint.

2. Prior to printing the publication go to the Print Setup Options to set the orientation in the
printer driver to be opposite to that of the first chapter. When the Bad Orientation error message



comes up, say "Yes" to automatically change to orientation of the driver to match that of the first
chapter.

Corel VENTURA Import Filter for Microsoft Word 2.0

Mastersoft Inc. supplies the Microsoft Word 2.0 import filter used by Corel VENTURA 5.0. This
version is identified as W4W44F.DLL (in the \COREL50\PROGRAMS directory, file size 132,176
bytes, date stamp September 20,1994). Mastersoft Inc. also supplies older versions of this filter
with other software programs. While loading text using the Word for Windows 2.0 filter in Corel
VENTURA 5.0, you may notice garbage text that appears at the top of chapter. If this is the case,
you may already have the W4W44F.DLL filter loaded in memory using another application. To
correct this problem, save your chapter, close Corel VENTURA 5.0 and restart Microsoft Windows
to remove the old W4W44F.DLL which was already in memory. Now try the import task again.

Corel VENTURA Files Exported as Microsoft Word 2.0 Files

Corel VENTURA 5.0 supports a Microsoft Windows Word 6.0 files import filter. Since Corel
VENTURA 5.0 does not support a Microsoft Windows Word 6.0 export filter, files will be exported
in Microsoft Windows Word 2.0 format.

CVPFIX.EXE Utility

Instead of integrating the files into one document, Corel VENTURA simply remembers where the
files are stored. It does this by maintaining a list of pointers in a chapter file. These pointers tell
Corel VENTURA where to find the text and graphics files and how to position them in the
formatted document. They also tell the program where to find the style sheet used to format
pages and text in the document.

Keeping the text and graphics files separate means that other documents can share the same
text and graphics. It also means that you can edit the files in other programs at any time.
Changes you make to the files are reflected in the Corel VENTURA document the next time you
open it.

Documents you create in Corel VENTURA can be divided into sections, called chapters, that
make up a publication file. Just as a chapter links the text and graphics files in a document, a
publication links the chapters so that you can manage each document as a unit.

When publications or chapters have been moved using Windows File Manager or a DOS copy
command, these pointers (the path) will be incorrect when opening the document. To correct the
pointers, use the CVPFIX.EXE utility. Corel recommends that you use the Publication Manager
to move publications and chapters.

To use CVPFIX Utility, use one of the following procedures:
1. From a command line:
- From the File menu of the Program Manager, select Run...
- type: [\path\] CVPFIX.EXE [\drive:] [publication name] [chapter name]



2. Add CVPFIX Utility to the Corel5 Program group:
- Make the Corel5 program group the active window.
- From the Program Manager, select File New. Select OK to add a Program item.
- For Description, type “CVPFIX Utility”
- For Command line, type C:\COREL50\PROGRAMS\CVPFIX.EXE (or appropriate path
where CorelDRAW is installed.
- For Working Directory, type c:\COREL50\PROGRAMS
- For Shortcut Key, type None. Click OK to accept responses.
-You can now double-click on the icon to launch the CVPFIX.EXE Utility.

Hint: You can perform a multiple file selection using standard Windows conventions.

Corel Equation Editor Fonts

The Equation Editor provided with Corel VENTURA 5.0 requires two fonts:
FENCES
MTEXTRA

The TrueType version of these fonts are installed with Corel VENTURA 5.0 by default. You can
install the Adobe Type 1 version of these fonts using Adobe Type Manager. These fonts can be
found on the following media:

1. On CD-ROM Disk #2:
- FENCES.AFM, FENCES.PFB, and FENCES.PFM are stored in the \FONTS\TYPE1\F\
directory.
- MTEXTRA.AFM, MTEXTRA.PFB, AND MTEXTRA.PFM are stored in the
\FONTS\TYPE1\M\ directory.

2. On Diskette #18:
- FENCES.AFM, FENCES.PFB, FENCES.PFM, MTEXTRA.AFM, MTEXTRA.PFB, and
MTEXTRA.PFM are stored in the \EE_FONTS, uncompressed.

Displaying Large Text Files in Copy Editor
When loading any large text file with many paragraphs, Copy Editor may not be able to display
the entire file.

Screen Capture Using Some Screen Drivers

There is a problem pasting screen captures created using some screen drivers, especially if 24-
bit images are stored on the clipboard. Corel recommends that you use Corel CAPTURE to
perform a screen capture, and use Corel Photo-Paint to save the screen capture to a file. With
this file, you can now load the graphic into a frame for use in Corel VENTURA 5.

Default Style Sheet
If you prefer other fonts, less tags or additional tags, than are shipped with the standard
Default.sty, do the following to update default.sty:

1. File/New

2. Plant cursor and change Body Text to the desired font
3. Layout, Save Style Sheet As. . .

4. Overwrite the Default.sty file in WENTURA\TYPESET

Now whenever File/New is executed, your new version of the default.sty will be used.



TagWrite Documentation

The TagWrite user documentation is provided in PDF format on CD-ROM Disk 1 in the \
TAGWDOCS directory. You can use Acrobat READER to display and print the documentation.
Acrobat READER can be installed by running the AASETUP.EXE from the \READER\DISK1
directory on CD-ROM Disk 1.

CorelCHART

Pasting in WordPerfect 6.0

When you double click a chart that has been pasted into WordPerfect 6.0 using Edit Paste,
double clicking the pasted chart causes WPDRAW to launch as the server instead of
CorelCHART. Use Paste Special to paste a chart into WordPerfect.

Patterns dialog box
The bottom five patterns in the Patterns dialog box always print black and white on color
PostScript printers.

Borders
Dotted and dashed lines are always printed in black and white on color PostScript printers.

Shadow command changed to Patterns command
In the Page Setup dialog box the Print Shadow command has been changed to Print Patterns.
Select the Print Patterns command to print all patterns in a spreadsheet.

In the Cut and Clear Options dialog box, the Shadow check box is replaced with the Patterns
check box.

SuperMatch Thunder 24Bit Video card

If you experience a General Protection Fault doing File and Open in CorelCHART and you are
using the SuperMatch Thunder 24Bit Video Card (driver date 3/29/94 revision number 3.10.061a),
switch to the Microsoft Standard VGA drivers.

Corel PHOTO-PAINT

- When working with black and white monochrome images using a Matrox MGA ULTIMA card (rev
1.00), we recommend you choose the 16 million color driver. If you use the 256 or 32K color
drivers, you may experience a General Protection Fault.

- When using a video card that supports 256 colors or less, the Tint Channels option in the
Preferences dialog box is grayed.

- When using a video driver that supports more than 256 colors, Screen Dithering in the View
menu is grayed out.

- When you Drag and Drop a 32bit CMYK object from Corel PHOTO-PAINT into CoreIDRAW (or
any other application that supports Drag and Drop) the 32bit CMYK converts to an RGB image.

- When importing a Corel PHOTO-PAINT file with floating objects into CorelDRAW, use the
MERGE command in the Object menu to combine the objects into a single image.

- The maximum number of objects in an image is determined by the size of the objects on-screen
and available memory.

- Afile loaded as a canvas must be 24 bit or 256 RGB color.

- The lighter colors in Rainbow fountain-fills used in gray scale images are considered white. Use
fountain fills that move from light to dark or from dark to light.

CorelSHOW



- Wait-for cues will only affect the objects within a slide. They do not delay the advance of the
next slide. Adjust the timing of the current slide to account for the Wait-for cue.

- If your show is going to be played on a system that does not have CorelSHOW installed, you
must provide the user with the CorelSHOW run-time player file, "CORELPLR.EXE". The
"CORELPLR.EXE" run-time file is in the programs directory.

- If you are using 3rd party animation files in your Show file, ensure that the runtime player or full
retail versions of these applications are on the target system. The file formats CorelSHOW
supports include: Autodesk Animator (.FLI) and (.FLC), Windows Video for Windows (.AVI),
CorelMOVE (.CMV), Macintosh QuickTime (.MOV)

- To ensure smooth play of your Show files, minimize the number of other applications running on
the system when your Show files are in use.

- Networks, magneto-optical drives, floptical drives and some CD-ROM drives do not play
animations at optimum speed.

- If there are animations in your Show file that do not play, make sure the appropriate MCI
animation driver is installed in the Drivers section of the Control Panel or run CorelDRAWS Setup
to install the correct driver.

- Extended characters are not supported in filenames.

CorelMOVE

- For information you must supply to users of your CoreIMOVE files who do not have CoreDRAW
installed, consult the How to section of CorelMOVE On-line Help.
- Sounds with characteristics which your sound card does not support, will play with degraded
characteristics in your animation, but will not play at all in the Wave Editor.
- Use the Wave Editor Amplify Effect if you want to increase the volume of a sound.
- CorelMOVE does not support 8 bit compressed .VOC files.
-16-bit sounds do not export to .SVX.
- If frames are skipping when you play a file in the media player which was exported to .AVI, try
disabling the "skip frames if behind" option in the device configure section of the media player.
- If you export a file with several sounds to Quicktime only the last sound listed in the

timelines rollup will export.
- The Microsoft Windows Sound System card is not recommended for use with CorelMOVE
because it is not fully compatible with CorelMOVE filters.
- When exporting to .MPG format sound must be 44KHz.
- Blending across layers when creating a CoreIDRAW OLE actor is no longer an available option.
However, you can blend across frames.
- Export to MPEG with sounds included may corrupt the exported video.

IMPORT FILTERS

Importing EPS files
When importing EPS files do not use the All Files (*.*) option in the List Files of Type list box. You
must choose a specific type of file such as PostScript (Interpreted) or EPS (Placeable).



PRINTING

EPS Files

EPS files placed in CoreIDRAW! and Corel VENTURA 5.0 are now parsed for DSC color
comments in order to determine the spot and process colors used. This is necessary in order to
properly separate them for Postscript output devices.

It is possible that some EPS files from outside sources will reference spot or user-defined colors
that are not directly supported by Corel Applications.. This includes Pantone Color names that
have been abbreviated (i.e. Pantone Wm Red). Separation of these colors is not supported.

If the message “unkown PANTONE color” appears in the separations colors list (in the
Separations tab of the Print dialog), then an unsupported spot or user-defined color has been
detected. This color will not separate properly and yield an empty separation. You should then:

1. Deselect the unkown color in the list before performing separations.
2. Recreate the EPS file using only colors recognized by Corel applications.

Printing Bitmaps on non-Postscript printers
If you are encountering problems with printing bitmaps to a non-Postscript, then try setting the
following flag in the \COREL50\CONFIG\CORELPRN.INI file:

DumpEntireBitmap = 0

The default value is 1 but some printer drivers may cause system errors if this flag is set to 1. (For
instance: LaserJet V.3.1.4)

Text prints on top of graphic
If on-screen text that is placed below a graphic, prints the text on-top of the graphic, add the
following switch to the [Config] section of the CORELPRN.INI file.

"UseTextBand = 0"

When set to zero, each character of text is sent to the printer as a graphic object. Keep in mind
that leaving this switch set to 0 decreases the quality and speed of printed text.

"UseTextBand = 1"
This is the default. It causes text to be printed using text bands instead of graphic objects.

Objects appearing black in print preview (WFW 3.11)

If you encounter problems with objects appearing black in the print preview when using Windows
For Workgroups 3.11 and the SVGA 256 color driver, add the following line to the CORELPRN.INI
file.

"BadPreview = 1"
= 0 This is the default.

Printing to HP Deskjet 1200C/Paintjet XL300

If the file size of the printed file is too large and causes out of memory error then modify the
CORELAPRP.INI file [Config] section. Change UseClippingForFills=3 to UseClippingForFills=1.
This drastically reduces the file size and the time it takes to print the file.

Printing Texture Fills to HP Deskjet 500 series printers
If Texture fills do not print correctly to HP Deskjet 500 series printers then users should contact
Hewlett Packard Technical Assistance to acquire the Printer driver version 4.10 or later.



Printing to Level 1 PostScript printers

The Level 1 PostScript language may not print certain complex fills (texture fills, full-color fills,
lenses etc.) placed in objects with multiple paths such as powerclips or text. Please consult the
CorelDRAW manual for trouble shooting suggestions.

Non-PostScript Printing

- When printing fractal and fountain fills using the Hewlett-Packard 4 Series printers, switch to
raster mode. The switch is accessed from the Printers utility of the Control Panel.

- See On-line Help for information on the printer-driver.

Scaling CROP Marks

A new entry can be added to the \COREL50\CONFIG\CORELPRN.INI file. The entry is:
CropMarksTolmage=1

This entry is used to provide printer’s marks at the corners of images rather that at the corners of

the logical page (set in the application) when CropMarksTolmage is set to 1. As images are

scaled larger or smaller in the Print Preview (Print Options dialog box), the marks will move in or

out proportionally with the scale factor. When CropMarksTolmage=0, crop marks will appear at

the four corners of page dimension.

Plotting/Printing to Large Media

When Plotting/Printing using a printer driver, the largest image possible is 32 inches by 32 inches.
The Center Option in the Print Options menu will not work correctly on media exceeding 32
inches by 32 inches. The Fit to Page option may cause the Width and Height margins to exceed
32 inches, resulting in a warning message. It is best to use the Scale Option with the Maintain
Aspect option selected. If printing to a Plotter using the HPGL format, you may wish to export to
HPGL to obtain the necessary image size.

CHANGES TO DOCUMENTATION

Extended Technical Support Program

In the Corel's Basic Support Services insert at the beginning of the CoreIDRAW 5 Volume 1
manual, please note the following changes: the phone number for Benelux is 011 31 3462 61123.
The alternate phone number for the U.K. is 011 44 703 814 142. (The first number listed for the
U.K. is correct.)

Libraries Catalog

SYMBOLS:

The symbol category called ANIMALS.TTF has been divided into two categories -
ANIMALS1.TTF and ANIMALS2.TTF.

In some earlier versions of the Libraries catalog:

CLIPART:

Some minor changes were made to the clipart included on CD-ROM Disk 1. For a list of changes,
refer to the CLIPART.WRI in the \CLIPART directory root.



MOVE LIBRARIES:
The index refers to a MOVE_PCX directory which has been renamed to MOVE\LIBRARY. All
actors and prop libraries (.MLB) will be found under this new directory.

The Old West actors described on pages F-21 and F-22 are located in the GREET1.MLB,
GREET2.MLB and GREET3.MLB files.

Sample Visual Basic for Applications Commands

"Page 342 of the CoreIDRAW User’s Manual Volume | refers to a file named "Sample.CDR".
Please be aware that no such file was shipped and that the file name was used (and intended)
strictly as a placeholder (i.e., filename.cdr, xxx.cdr) when describing the sample Visual Basic
printing and export programs."

The \DRAW\SAMPLES directory contains the following sample code. You will require Microsoft
Visual Basic to compile this code.

1) DRAWAUTO.FRM

2) ABOUT.FRM

3) WINAPIL.BAS

4) DRAWAUTO.MAK

5) CORELOLE.EXE

Changes to the CoreIDRAW 5 User’s Manual Volume 2

The CorelIDRAW 5 User’s Manual Volume 2 has been reprinted for Revision E2. The following is
a list of corrections to the Corel VENTURA section.

Page 14: Base Page and Pasteboard

The Pasteboard extends to the area below the base page, not just to the right of it as stated in
the manual.

Page 28: Undocumented features: Auto-panning and Interruptible Display

Corel VENTURA automatically scrolls your view of the base page when you drag a free frame or
graphic object beyond the edges of the document area. Auto-panning occurs only when the
window size or magnification factor is set such that less than the entire base page is visible.

With Interruptible Display, the screen stops refreshing when you click with the mouse or press
the ESC key. If either of these actions occurs while a graphic is in the process of redrawing,
refreshing stops when the graphic finishes redrawing. This lets you select a menu command or
tool without waiting for the screen to redraw completely. Redrawing resumes after you perform
another action. Click on a scroll bar thumb or when you choose the Refresh Window command in
the View menu.

Page 31: Printing a document

Multi-chapter documents formatted as booklets must be printed chapter by chapter using the
Print command; using the Print Publication command to print the entire document only works for
single chapter booklets.

Page 48: Widow and orphan lines

A widow line is the last line of a paragraph printed by itself at the top of a page or column; an
orphan line is the first line of a paragraph printed by itself at the bottom of a page or column.



Page 55: Creating a layout using the Quick Formats Roll-Up.

A frame must already have a multi-column layout before you can apply another one from the
Quick Formats Roll-Up. In other words, you can't use the Quick Formats Roll-Up to add
additional columns to a document with a single-column layout.

Page 67: Adding backgrounds and borders to frames

The Oultine tool cannot be used to add borders to frames--at least not as described in the
manual. However, you can select any of the buttons in the tool's flyout menu to access the
Ruling Lines dialog box.

Text in a frame with a black background does NOT automatically change to white, even if you're
printing to a device that supports white on black printing.

Page 72: Setting text flow attributes

To get text to flow around a free frame the frame containing the text must be below the other
frame in the stacking order. Since the base page frame is always at the bottom of the stack, text
in it will always flow around a free frame unless the Flow Text Around Frame option is turned off
for that free frame. If you have overlapping free frames and you want text in one of them to flow
around a graphic in one of the others, the one containing the graphic must be first in the stacking
order. To move a frame to the top of the stack, cut and paste it.

Page 79: Rotating frames

Corel VENTURA accepts only positive values between 0 and 360 for frame rotation in the Frame
Settings dialog box.

Page 82: Anchoring free frames

In order to anchor a free frame there must be enough room on the page for both the frame and
the line of text containing its anchor. If you change a document such that the frame and the text
no longer fit on the same page (perhaps because you enlarged the frame so that it completely
covers the base page) that frame will move to the end of the chapter when you re-anchor the
frames. The easiest way to fix this problem is to make the frame in question smaller.

Page 96: Inserting fixed width spaces

An em is a unit of measure which is more precisely defined as being equal to the point size of
the text not the width of the letter M as the manual states.

Page 100: Importing text

Font and size attributes in a text file are NOT perserved when the file is imported into Corel
VENTURA.

Page 101 and 157: Add to Files List check box

The manual says that enabling the Add to Files List option in the Load Text and Load Graphics
dialog box adds the imported file to the Files List for all chapters in the open document. That's
wrong. What it does is add the file to the Files List in the current chapter without replacing the file
that might already be in the selected free frame. (Corel VENTURA never replaces a file on the
base page regardless of whether the Add to Files List option is enabled .)



Page 105 - 106: Determining whether all text has been placed in a frame

Instead of a selecting options from a list box to go to the first, next, previous or last page
containing text from a selected file, you use the buttons at the top of the Go To Page dialog box.
(The actual dialog box is different from the one pictured in the manual.) The leftmost and
rightmost buttons go to the first and last page; those in the middle go to the next and previous

page.
Page 112: Creating a personal spelling dictionary

You can't create a personal spelling dictionary from within the Spell Check dialog box. Instead,
use Windows Notepad (or any other application, including Corel VENTURA, that saves text in
ASCII format) to create an empty text file. Name the file whatever you want, but give it a PD
extension and save it the COREL50\CUSTOM directory. The file's name will appear in the
Dictionary list in the Spell Check dialog along with the built-in personal dictionary (SPLDICT.PD).
Page 115: Saving text under a different name or file format

Corel VENTURA does NOT provide an option that lets you remove the formatting codes it
inserts in text files.

Page 120: About local formatting

Corel VENTURA inserts a diamond symbol at the beginning of paragraphs with local formatting.
As with other text symbols, you'll only see the diamond when the Tabs and Returns option in the
Preferences dialog box is enabled.

Page 128: Number of tags permitted in a style sheet.

Corel VENTURA limits the number of tags in a style sheet to 128.

Page 134: Using the Side-by-Side Paragraphs button on the ribbon.

To use the button, first select the paragraphs by holding down the Alt key and clicking on them
with one of the Text tools.

Also, contrary to what's stated in the manual the Text tool that's used to apply the side-by-side
formatting determines whether it's applied to the selected paragraphs only, or to all paragraphs
with the same tags as the selected paragraphs. To apply the formatting just to the selected
paragraphs, use the Freeform text tool.

Page 142: Rotating paragraphs

You cannot edit rotated paragraphs unless you return the paragraph to 0 degrees rotation. To
select a rotated paragraph, hold down the Alt key and click on it with the Text tool.

Page 158 - 159: Cropping and resampling a bitmap before importing

You can neither crop nor resample a bitmap from the Load Graphic dialog box in Corel
VENTURA. However, both operations can be done in Corel PHOTO-PAINT.

Page 159: Cutting, copying and pasting graphics
The statement that pasted graphics are stored in the CHP file as opposed to a separate file

applies to linked or embedded graphics. Graphics pasted with Corel VENTURA remain as
separate files.



Page 164: Wrapping text around graphics
Corel VENTURA's text wrap feature doesn't work with linked or embedded graphics.
Page 165: Showing and hiding graphics

Frames containing graphics display with an X in them when graphics are hidden regardless of
whether the graphic is a bitmap or vector.

Page 171: Using the drawing grid

In order to have graphic objects snap to the grid, the Snap to Grid option in the Grid Setup dialog
box and the Snap to Grid command in the Layout menu must both be turned on. The option in
the Grid Setup dialog box is a local switch that turns snapping on and off for individual frames
while the command in the Layout menu is a global switch that turns snapping on and off for
frames that have snapping turned on.

Page 179: Correction on applying outlines and fills to several graphic objects at the same time

Contrary to what's stated in the manual, you can apply the same outline and fill to several
different types of graphic objects at once.

Page 192: Correction on using Quick Format Roll-Up to add headers and footers

Clicking Apply in the Quick Format Roll-Up opens a dialog box so that you can enter the text you
want to appear in the header or footer.Thus, there's no need to use the Chapter Settings
command to insert the text as stated in the manual, although you will need to use the command
to edit the text thereafter.

Page 328: Default Hyphenation setting in the Preferences dialog box

Chapters created in previous versions of Corel VENTURA (3.x and 4.x) lack information
identifying the language dictionary used to hyphenate text. Before opening such chapters, use
the Preferences command in the Tools menu to specify the appropriate dictionary.

Page 378: Importing fully styled Word 6, WordPerfect 6, and SGML documents

There are no application-specific TagWrite import filters but rather a single filter (called TagWrite
- Style Match RTF) that lets you import text files in RTF format. The other TagWrite filter,
referred to as the TagWrite SGML Template in the manual, is actually called *TagWrite - SGML
/Custom Template in the program. While its name has changed, the filter's function remains the
same, namely to access templates created using the TagWrite Template Editor.



DOCUMENTATION REMINDER

The CorelDRAW!5 Installation Guide contains detailed and timely information concerning the
installation of your new software. Should you run into any difficulties, it's your front-line of
help. It should answer most of the common installation questions.

The On-line Help files are more current than the printed manuals and documents. They contain
information not available at the time of printing. Where there is a disagreement between the
printed material and the On-line material, follow the on-line recommendations.

Please forward suggestions for improvement of any component of your CoreDRAW!5
documentation package (manuals, guides, on-line Help, the Tutorial or the Quick Tour) to:

CorelDRAW Documentation Manager
Corel Corporation

1600 Carling Avenue

Ottawa, Ontario,

CANADA

K1Z 8R7

SOFTWARE SUGGESTIONS AND COMMENTS

Forward suggestions for improvement or any new functional requirements for any component of
your CorelDRAW!5 product to:

CorelDRAW Product Manager
Corel Corporation

1600 Carling Avenue

Ottawa, Ontario,

CANADA

K1Z 8R7

End of Readme File



